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Release Notes - Quantrix Modeler
To view these release notes with live links, and/or to see prior versions of Release 
Notes, view them here at the Quantrix web site. 

Quantrix Modeler 21.1.0
Improvements in Version 21.1.0

Modeler includes a new top-level menu option called Community that includes the 
new Bulletins feature described below, and two options that had been under the 
Help menu: Ask a Question (the forum), and Support Portal.

 

Quantrix introduces a new feature called Bulletins that lets you see Quantrix news 
about product updates, features and perks from within Quantrix Modeler 
by clicking a small bell-shaped icon in the taskbar (QM-24123)

The green Bulletin icon is a notification of unread bulletins that you can view by clicking 
the icon or clicking the menu option under Community > Bulletins. The number of 
unread bulletins displays when you hover over the icon and also shows next to 
Community > Bulletins. If there are no unread bulletins, the bell icon is a faded blue 
color.  
In the Bulletins toolpane, the bulletin titles are bold (meaning the bulletin is unread) or 
not bold (read). Click Mark All Read in the bulletins toolpane to mark all messages as 
read, and use the toolpane check box to choose if you want read bulletins displayed. 
Although bulletins expire automatically, you can right-click and delete them if desired.  
See the Bulletins help topic for more.  

Format Painter has been improved, and reduces the steps involved while adding 
functionality QM-24147:

Select the base cell (the cell whose format you want to copy)
Click the Format Painter toolbar button once if you want to apply the format once as a 
single paste action
The cursor changes to a Paintbrush icon
Click to select the target cell(s) and release to paint
You can now engage Format Painter mode for more than one paste action:
Select the base cell
Double-click the Format Painter toolbar button and the toolbar button is outlined to 
indicate the painter is "locked" in paint mode
Format Painter continues to apply the paint format to any cells or ranges you select until 
you turn it off by clicking the Format Painter button or by pressing Esc

https://quantrix.com/quantrix-release-notes/modeler-release-notes/
https://quantrix.com/help/modeler/Bulletins.htm
https://quantrix.com/help/modeler/Bulletins.htm
https://quantrix.com/help/modeler/Editing_Data.htm#CellFormatPainter_5.1_2398
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Modeler offers an option (preference) called "Allow drag to replace categories" 
that lets you drag a category to replace a category in another matrix while also 
linking the dragged category. This option/preference is enabled by default.  When 
enabled, category replace lets you drag a category from one matrix to another 
matrix, and drop the category on top of the category you want to replace. Please 
see the Using Replace Categories topic in the help for important details and rules 
(QM-24094, QM-24198) 

Adding categories has been improved for ease of use, and you can now add 
categories by clicking a small add category button that shows on both row and 

column axes for matrices,  (QM-24092):

The add category button is available unless you lack permissions, or have exceeded the 
limit of 16 categories
The add category button is not available for filter tray categories, on canvases or charts
If a matrix has no categories on an axis, the add category button is available
Clicking the add category button adds a category after an existing category or 
categories on an axis; clicking Shift + add category button adds the category before any 
categories on an axis
Undo is available for the add category button

Note: Other than the Adding a Category topic and selected others, the online help images will be 
updated to reflect the new add category button in a subsequent release.

Quantrix Modeler navigation between categories and items has been improved for 
usability, so that you can use Tab to move from a selected category to go to the 
first item. Use Shift + Tab to move back from an item to the category, in both 
matrices and charts  (QM-24095).

If the category is on a filter tray, or point or series axis (in a chart), Tab goes to the first item of the 
first row category. If there are no categories on the row tray, Tab goes to the first item of the first 
column category.

When using shift-tab, if there is nothing uncollapsed to the left of the current selection and the current 
selection is an item or group, shift-tab moves the selection to the category of that group or item. When 
tabbing from a filter tray category to a row or column item and shift-tabbing out to that row or column 
category shift-tab does not move back to the filter tray.

When you rename a default category name, provided you haven't changed the 
default item name for that category, the item name(s) are automatically renamed 
to match the category name. For example, for a new matrix with the default 
category named "A", if you rename category "A" to "Products" the associated item 
is automatically renamed to "Products1" from the default name of "A1". If you 
have category "A1" with multiple items (A1, A2, A3, A4, etc.) and you rename 
category "A" to "Products", all items are automatically renamed to "Products1, 
Products2, Products3, Products4, etc.). This improvement makes it easier to 
rename multiple categories and immediately see which items belong to which 
categories (QM-24091)

Users who use have created a plugin or have been provided with a plugin for use 
with Quantrix Modeleler can now easily manage plugins from the Tools 
(Preferences) > Manage Plugins option (QM-24100). A plugin is a custom code 

https://quantrix.com/help/modeler/Setting_Matrix_Options.htm
https://quantrix.com/help/modeler/Using_Category_Replace.htm
https://quantrix.com/help/modeler/Adding_a_Category.htm
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package in the form of a .jar file that is designed to work with Modeler and has 
been verified as safe and as working correctly by you or your plugin provider. 
Please see the Manage Plugins topic for more.

Messaging is improved when publishing a model to Qloud if the Modeler and 
Qloud application versions differ: "Publish Error:  Modeler and Qloud versions 
differ and are incompatlble. Public Qloud users should ensure their Quantrix 
Modeler version is up to date using Help > Update Quantrix.
Enterprise Qloud users should check with their Qloud administrators to ensure 
they are on a compatible version (QWC-4149)

In Data Import (and DataLink), provided the data source file structure is the 
same, Quantrix retains the csv & fixed width data source configuration for data 
types and column labels when users access the data source from a different file 
location (QM-23201)

The Update Data Import process and interface are improved in the scenario 
where a previously configured non-data import category location no longer exists. 
The prompt no longer displays that said "Change Data Import Location". Instead, 
the Data Import will be in error and entering configuration mode will 
automatically display the broken location in the options pane and you can choose 
a different location (QM-23889)

Data Import's Import > Clipboard now supports using CTRL-V to paste copied 
delimited text into a Data Import clipboard matrix. For example, you can copy 
spreadsheet data, open a model, and pressing CTRL-V automatically opens the 
Import from Clipboard dialog and pastes your copied data to the clipboard matrix. 
You can also use CTRL-V when there is an empty matrix, or when your focus is on 
a model browser selection (QM-24096) 

Formula auto-complete is improved and displays qualified names in the list when 
different components (such as Item and Group) have the same name: this helps 
you determine the correct name to select for the formula (QM-23923)

The match() function has been improved and now matches explicitly on a 
NULL value. Match() accepts an empty string as an argument and returns the first 
index of an empty value in the list. This might be helpful if, for example, you want 
to use a formula to calculate only the cells that precede a NULL or that are not 
NULL (QM-24184) 

Formula deleting has been improved: When you delete a formula using Delete or 
Backspace, the current formula is deleted and the selection moves to the next 
formula following the deleted formula (any following formulas are moved up to 
occupy the rows contiguously) so that you can continue deleting if desired. If 
there are no formulas following the deleted formula, the selection moves to the 
previous formula (QM-24156)

For usability, newly created List and Category constraints no longer have 'Convert 
to numeric values' selected (QM-23807)

https://quantrix.com/help/modeler/Manage_Plugins.htm
https://quantrix.com/help/modeler/Configure_Update_Options_for_Import.htm#Put_imported_data_in_Using_Edit_pencil_for_Import_Location


6

The online help system delivers significant new functionality and a more modern 
design. New capabilities include improved search and search result navigation 
with highlighter control, and enhanced topic actions such as favorites, sharing, 
emailing and printing. For details, please see the help topic How to Use Help.

For ease of use, a new option is available on the model tab's right-click menu to 
rename the selected view (QM-23922)

An MSI installer for installing Quantrix Modeler on Windows is available upon 
request. The installer includes supporting files including install and uninstall batch 
files and driver files (QM-24182)

The Java version is updated to the latest Corretto JDK version on both Windows 
and Mac, to Corretto 1.8_265.

 

Significant Fixes in Version 21.1.0

When a data import matrix contains collapsed rows, new data comes in correctly 
and is not collapsed (whether it is created by users, or is brought in using Data 
Import) and is visible (QM-23874)

A Change Data Import data location prompt that sometimes appeared for invalid 
data locations, such as on model open or as a result of a data update script 
running or deleted locations no longer appears: in these circumstance, better and 
more informative messaging is supplied (QM-23968)

A specific scenario involving database data updates using a 
performWithAuthentication script should no longer prompt for authentication info 
(username and password) provided you chose to save credentials (QM-24061, 
F0122055)

Data Import from Snowflake is now supported using the Snowflake JDBC driver 
(QM-24085, F0121909)

When updating DataPush and Data Import matrices that contain linked primary 
key categories the primary key is correctly retained and used by both data 
updates (QM-24056, F0121831)  See related known issue.

When you copy a Data Import matrix that has a filter containing an expression 
qualifier that references a renamed matrix, reloading or pasting and loading the 
copied matrix uses the correct, renamed matrix name in the expression qualifier 
(QM-24081, F0122129)

Line and scatter plots now select and display the selection correctly (QM-23883)

The rounddown, trunc, round, roundup and percentile functions now work 
correctly for numbers with leading 0-decimals (QM-24133, F0122862)

https://quantrix.com/help/modeler/How_to_Use_Help_R2020.htm
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Expressions in nested group titles and in shapes/text objects nested inside groups 
now evaluate and calculate correctly when pasted. (QM-20587, F0077001)

When using the functions sumif and countif, numbers that are formatted as text 
are converted to numbers for comparison if the test value is a number. If you 
want to match a cell value with a string, use quotes (for example, use '24' to 
match a cell value with the string 24).
When using sumif, numbers that are formatted as text are not included in the 
sum (QM-21030, F0078557)

CountIf now recognizes items to count even if they start with characters such as 
# (for example,#10202): #string will match any error that has message #string 
and any string values that match #string. (QM-19078, F0067438)

Formulas containing certain non-ASCII characters no longer result in the 
Dependency Inspector omitting formula lines: the formula section of the 
Dependency Inspector now displays the complete formula  (QM-23015, 
F0094554)

The Interpolate Missing Values option for Plot and Statistical Plot charts no longer 
spans values that come from different series (QM-23935, F0118869)

An exception no longer occurs related to category item generation with Undo/
Redo when adding/removing or calculating generated items (QM-24134 , 
F0120239)

Exceptions no longer occur when invalid arguments are entered in Generate Items 
and formulas (QM-23939)

Calculation performance has been improved from 20.2.0 for deeply recursive 
models containing a large number of cells and that uses scripted functions in 
formulas that have deep recursion (QM-23946, QM-23956, F0119344)

When saving a model, the Save dialog should no longer show multiple entries for 
the .model file extension in the Files of Type field (QM-22506)

Date and Time fields imported from text files are shown in the correct date/time 
order regardless of how they are configured (QM-23936)

Conditional formatting now overrides settings for cell and notes indicators in Tools 
> Options > Matrix when the indicators use background colors (QM-24176)  
When you use background colors, the order of precedence is Solver Cell > 
Conditional Format > Note Indicator > Cell Indicators > Normal Format 

Note indicators (triangle icons) and constraint violation indicators (for Value not 
allowed or Value empty flags) now display in cells containing hyperlinks and 
images (QM-21788)

An exception related to using custom number formats in certain scenarios no 
longer occurs (QM-20975)
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An exception that occurred with the Arabic language pack installed, and moving 
categories to the filter tray, no longer occurs (QM-24022)

An exception that occurred when certain constraint ranges and cell coordinates 
didn't match should no longer occur (QM-23822)

An exception that sometimes occurred related to adding shapes to a canvas 
should no long occur (QM-21670)

An exception no longer occurs in some cases while inserting Items multiple times 
(QM-23901)

An exception no longer occurs when using the SQL SELECT DISTINCT command 
(QM-23891)

An exception no longer occurs with primary key categories in certain scenarios, 
such as when dragging a primary key category from a table view on a canvas to 
the canvas filter tray, or to a matrix filter tray and hovering over it, or when 
adding a table to a canvas that has a primary key category in the filter tray 
(QM-23788)

An exception no longer occurs in a very specific scenario involving a matrix view 
on a canvas in interaction mode, selecting an item and using Ctrl-Z to Undo while 
the mouse pointer is on the matrix canvas view (QM-21914) 

When a canvas is closed, and you add or remove items, the snapped matrices 
now display the changes correctly in the PDF and Print/Print Preview (QM-23871)

An exception related to items generated with Generate Items and the use of Undo 
no longer occurs (QM-24029)

Models with intermodel links no longer get an exception related to updating 
intermodel links when the source file changes, and when using Recalc options 
with Undo/Redo, with scripts (QM-21724)

Exceptions no longer occur in Data Import after updating from the Data Import 
tab, removing categories and then using Undo (QM-24165)

An exception no longer occurs when you are in a data import configuration that 
references a matrix, and you delete that referenced matrix from the model 
browser (QM-23620)

An error no longer occurs when opening a model that was saved in an 
inconsistent state (QM-21322, F0080106)

On macOS, entry of Chinese and Japanese characters in items, cells and 
categories using an IME now works correctly (QM-19196, F0067968)
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On macOS, detached views now remain on the display they are moved to, rather 
than moving back to the original display when the focus changes (QM-19257, 
F0068701)

On macOS, color-coded tags assigned to models are retained when models are 
opened and re-saved provided you have permission to save and the model is not 
read-only (QM-20937)

On macOS, copying and pasting a view from a Presentation Canvas into another 
canvas or application pastes correctly and no longer sometimes includes extra 
gray around areas of the pasted canvas (QM-19644, F0071854)

On MacOS, when the International System setting 'Use System Fonts' is enabled 
in Preferences, the Filter panel now sizes correctly and shows all of the text 
(QM-24034, F0121195)

Model data formatted on a Mac in Chinese fonts now display correctly on Windows 
and no longer appear blank (QM-23094, F0105101)

 

Known Issues in Version 21.1.0

Plot charts containing collapsed data may not show legend selections correctly 
(QM-23918)

DataPush and Data Import that use multiple primary keys will not work properly if 
they share the primary key category

On MacOS, when using detached views that cover the main view, some dialogs 
may appear behind the detached view. Moving the detached view and clicking the 
dialog brings it to the front (QM-23275)

When you are using an IME, typing a character when a cell is in focus but is not 
being edited puts the IME in the upper left corner of the primary screen. 
Committing text does put the text in the cell, and you can use the IME on the cell. 
To avoid this scenario, begin your edit by pressing F2.
In some cases, using the arrow key when an IME is in use moves the selection 
and ends the edit.
Certain Asian characters in a model's hyperlinks cause the hyperlink to fail 
(QM-19196)


	Contents
	Release Notes - Quantrix Modeler
	Quantrix Modeler 21.1.0
	Improvements in Version 21.1.0
	Significant Fixes in Version 21.1.0
	Known Issues in Version 21.1.0



